Microsoft Office Graphics
The features listed below are graphic components that work in all of the Microsoft Office programs (Word, Excel, PowerPoint, and Publisher). The steps listed work in Microsoft Office XP/2003.
Two Types of Graphics – Bitmap and Vector 
There are basically two types of graphics—bitmap and vector.

· Bitmap Graphics – These graphics are usually created in paint programs or come from digital cameras and scanners. They are made up of pixels. When small bitmap graphics are sized to a much larger size, they become fuzzy, because each pixel is increased in size. Examples of bitmap graphics are .bmp, .gif, .png, .jpg, and .jpeg.

· Vector Graphics – These graphics are usually created with drawing programs, which make up several pieces of the graphics that can be edited (moved, sized, filled with color, etc.) very easily. When vector graphics are sized to a larger size, they still look good, because each piece of the drawing is recalculated and resized.

Display the Drawing Toolbar
Many graphic tools are displayed on the Drawing Toolbar. Follow the steps below to open the Drawing toolbar.
1. Right-click on the menus at the top of your screen

2. Choose Drawing
3. The Drawing toolbar will be displayed at the bottom of your screen

Clip Art

Office automatically searches for Clip Art from Microsoft’s Online Clip Art Gallery. When Clip Art is displayed in the Task Pane, if the Clip Art has a picture of a globe in the lower right-hand corner, it is from the online Clip Art Gallery.

1. From the Insert menu, choose Picture and then Clip Art
- or -

2. Click on the Clip Art tool [image: image30.png]Print
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 on the Drawing toolbar
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Size Picture

1. Click on the picture to select it  
2. Point to one of the selection boxes (or circles). These are the boxes/circles that appear around the picture when you click on it. They let you know that the picture is selected.
3. When mouse turns into double-black arrow, click and drag.

Size a Picture and Keeping it in Proportion

To size a picture and keep in proportion (not too tall or short or fat or thin), size it from a corner.

Size Picture to Specific Height and Width

1. Right-click on the picture

2. Choose Format Picture
3. Click on the Size tab

4. Type a number in either the Height or Width box

5. Click on OK
Move Picture

1. Point in the middle of the picture

2. When mouse changes to the 4-headed arrow,  
[image: image2] click and drag. 
Rotate Picture

1. Click on the picture to select it

2. Click on the green circle at the top of the picture and drag

Picture from File

To insert pictures that you have saved on your computer (Ex. from a digital camera, a scanner, pictures you have created, or pictures you have saved from the Internet)
1. From the Insert menu, choose Picture and then From file
-or-
2. Click on the Insert Picture tool [image: image3.png]


 from the Drawing toolbar

Show Picture Toolbar

When you click on a picture, the Picture Toolbar should appear. If it doesn’t, do the following:

1. Right-click on the Picture

2. Choose Show Picture Toolbar
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Crop
Cropping allows you to cut off the edges of a picture. In Office, the picture is not actually cropped, but the edges are hidden. If you drag the edges back out using the crop tool, they will reappear.
1. Click on the Picture

2. Click on the Cropping tool [image: image5.png]


 in the Picture Toolbar 
3. Click and drag on one of the selection bars
Undo

Use the Undo tool [image: image6.png]


 on the Standard toolbar to undo the last thing you did. You can click on the Undo tool several times to keep going back.

Washout (Watermark), Grayscale, and Black and White - Color Tool
To change the picture to Washout (Watermark), Grayscale, or Black and White:

1. Click on the Picture

2. Click on the Color tool [image: image7.png]


 on the Picture Toolbar

Compress File Size of Pictures
Use the Compress tool on the Picture toolbar to reduce the memory size of picture files.

1. Click on the picture

2. Click on the Compress Pictures tool [image: image8.png]


 on the Picture Toolbar
3. Choose All pictures or Selected picture

4. Choose Web/Screen
5. Click on OK and then Apply
Edit Picture

You can change a Clip Art by editing it. When you edit a Clip Art, it is no longer a picture—it is converted into a drawing and divided into the small pieces that make up the drawing. Only vector graphics such as .wmf and .emf files can be edited. Bitmap files such as .bmp, .gif, and .jpg cannot be edited.
1. Right-click on the Picture

2. Choose Edit Picture

3. Click on Yes
4. Click off of the picture to deselect all of the items

Change Colors of the Items in the Edited Picture

1. Double-click on the item to change

2. Click on the Colors and Lines tab
3. Choose a Fill Color and click on OK
Ungroup the Edited Picture

Once you have chosen to edit the picture, the pieces are still grouped together. To change the individual pieces, you need to ungroup them.

1. Right-click on the picture

2. Choose Grouping and then Ungroup
Regroup the Editing Picture

If you have not added any objects to the picture, you can regroup it as one picture.

1. Right-click on any part of the picture

2. Choose Grouping and then Regroup
Group the Edited Picture Plus Any Added Objects
When finished editing the picture, if you have added any objects that were not in the original picture, you will need to Group (Not Regroup) all of the pieces together as one.

1. Point the mouse above and to the left of the picture

2. Drag and draw a selection box around the picture to select all of the pieces of the picture

3. Right-click on the picture

4. Choose Grouping and then Group
Size an Edited Picture (Drawing) and Keeping It in Proportion

1. Hold the Shift key on your keyboard

2. Size from a corner
Save As Picture

In PowerPoint, you can save an edited picture back to a regular picture file to use in other programs and/or save your own drawings as picture files. The best file type to choose is .emf (Enhanced Windows Metafile) unless you will be using the graphic on a Web page, and then you should choose .gif. Photographs should be saved as .jpg.
1. After selecting all of pieces of the picture or grouping them together, Right-click on the picture

2. Choose Save As Picture
3. Type a filename, set your location, and set the File Type (best choice is Enhanced Windows Metafile .emf)

WordArt

1. Click on the WordArt tool [image: image9.png]


 on the Drawing toolbar
2. Choose a design and click on OK
3. Type the desired words and click on OK (Do not press Enter, for this will put a blank line below your WordArt.)

Move WordArt

To move WordArt, you must point to one of the letters until the mouse pointer changes to a 4‑headed arrow and then click and drag.

Yellow Diamonds in WordArt

Most of the WordArt shapes contain yellow diamonds. Use the yellow diamonds to change the angles and such of a WordArt.

Show WordArt Toolbar

1. Click on the WordArt to display the WordArt Toolbar
- or -
2. If it does not display, right-click on the WordArt and choose Show WordArt Toolbar
WordArt Toolbar
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Fill Colors and Effects

WordArt and objects you draw can be filled with colors, gradients, textures, patterns, and pictures.
1. Right-click on the WordArt

2. Choose Format WordArt
3. Click on the Colors and Lines tab
4. Click on the drop-down arrow for Fill Color and choose any one of the following:

a. No Fill

b. A color listed

c. More Colors

d. Fill Effects

i. Gradient

ii. Texture

iii. Pattern

iv. Picture

Change Background Color and/or Fill of a PowerPoint Slide

1. Right-click on a blank area of the slide

2. Choose Background
3. Click on the drop-down arrow and choose a new color or choose Fill Effect
Shadow and 3-D with WordArt

1. Click on the WordArt

2. Click on the Shadow tool [image: image11.png]
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 on the Drawing Toolbar and choose a desired shadow or 3-D effect

Shadow and 3-D Color

· Turn on the Shadow Settings Toolbar by clicking on the Shadow tool [image: image13.png]


 on the Drawing Toolbar and choosing Shadow Settings
· Turn on the 3-D Settings Toolbar by clicking on the 3-D tool [image: image14.png]


 on the Drawing Toolbar and choosing 3-D Settings
Button with WordArt

1. Click on the WordArt tool [image: image15.png]


 in the Drawing Toolbar
2. Choose a format and click on OK
3. Type 3 lines of text or type a line of text, press Enter twice and type another line of text

4. Click on OK
5. On the WordArt toolbar, click on the Shapes tool [image: image16.png]


 and choose the Button tool [image: image17.png]D




6. Use the yellow diamond(s) on the WordArt to change the spacing of the text.
Screen Capture – Entire Screen
You can take a picture of your screen and paste it into any program that accepts graphics.
1. Press the Print Scrn button  on the keyboard

2. Open a document and Paste
Screen Capture – Current Window

1. While holding the Alt key on the keyboard, press the Print Scrn button on the keyboard

2. Open a document and Paste
_________________________________

Drawing

Use the tools on the drawing Toolbar to make your own drawings in Office programs.

Display the Drawing Toolbar

1. Right-click on the menus at the top of your screen

2. Choose Drawing
3. The Drawing toolbar will be displayed at the bottom of your screen
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Drawing with Shift—the Magic Key

The Shift key does many things while drawing in Microsoft Office Programs. Following is a list:

· Draw straight lines

· Draw perfect circles, squares, triangles, etc.

· Size from corner to keep drawing objects in proportion

· Select more than one object

Draw Many Lines, Ovals, Rectangles, etc at the Same Time

To keep a drawing tool active, double-click on the tool and then draw the objects
Select More than One Object

Many times you will need to select several drawing objects at once. Following are two methods for selecting several objects at once.
· Shift key

· Draw a selection box around the items

Delete Drawing Objects and Pictures

1. Select the object(s)

2. Press the Delete key on the keyboard

Typing in Shapes

1. Select the shape

2. Start typing
Change Fill Color and Line Color in Shapes

1. Double-click on the shape

2. Change the Fill Color and/or Line Color
AutoShapes

Use the AutoShapes tool [image: image19.png]Autoshapes ~



 on the Drawing toolbar to draw triangles, smiley faces, hearts, call outs, scribbles, freeform shapes, flowchart symbols, etc.

Freeform Tool – Drawing Your Own Shapes

The Freeform tool allows you to draw your own shapes.

1. Click on the AutoShapes tool on the Drawing toolbar
2. Choose Lines and then Freeform [image: image20.png]



3. You can use the Freeform tool in three different methods. In all of these methods, to end the drawing, click where you started or double-click.

a. Click, move the mouse, and click again. Repeat this until you have drawn a shape with lines. 

b. Click and drag, which turns the mouse-pointer into a pencil.

c. Combine the straight lines and the pencil by alternately click, click, clicking and dragging.

Freeform Objects – Editing Points to Refine a Drawing

1. Right-click on the Freeform drawing
2. Choose Edit Points
Order

When objects overlap, you can send objects to the front, back, forward, or backward.

1. Right-click on the shape

2. Choose Order
3. Choose the desired direction. Remember, the following:

a. Bring to Front – brings to very front

b. Send to Back – send to very back

c. Bring Forward – brings forward one layer

d. Send Backward – sends backward one layer

Align and Distribute

Use the Align feature to align objects to their tops, bottoms, centers, lefts, and rights. Use the Distribute feature to evenly distribute items across or up and down an area, placing the same amount of space between objects.

1. Using the Shift key or selection box, select the objects to be aligned or distributed.

2. Click on the Draw button [image: image21.png]Draw~



 on the Drawing toolbar
3. Choose Align or Distribute
Group/Ungroup

1. Select the objects by drawing a selection box over them or using the Shift key

2. Right-click on the objects

3. Choose Grouping and then Group (or Ungroup to separate the objects)

Grid

The grid is like graphing paper in the background of your Office program. When you draw or move objects, they are automatically snapped in to the lines on the grid. This is why sometimes you cannot move an object exactly where you want it. Use the following steps to turn OFF the grid:

1. Click on the Draw button [image: image22.png]Draw~



 on the Drawing toolbar
2. Choose Grids and Guides
3. Turn off Snap to Grid
Flip Objects

Flipping is different than rotating. Flipping allows you to make mirror images of objects.

1. Select the object to Flip

2. Click on the Draw button [image: image23.png]Draw~



 on the Drawing toolbar
3. Choose Rotate or Flip
Text Boxes

Text boxes allow you to place text anywhere you’d like in a document. For example, in Word, use a text box to place text in the right or left margin.

1. Click on the Text Box tool [image: image24.png]


 on the Drawing toolbar
2. Draw a box

3. Type
Move a Text Box

To move a text box, you must click on the Border of the text box and drag.

Changing the Border or Fill of a Text Box

1. Double-click on the border of the text box

2. Click on the Colors and Lines tab
Diagrams

There are six preprogrammed diagrams you can create in Office programs—Organizational Chart, Cycle Diagram, Radial Diagram, Pyramid Diagram, Venn Diagram, and Target Diagram.

1. Click on the Diagram tool [image: image25.png]


 on the Drawing toolbar
2. Choose the desired diagram and click on OK.

Save PowerPoint Slide as a JPEG

You can save the entire slide as a JPEG (picture) file.

1. File menu, Save As
2. In the Save as Type box at the bottom, choose JPEG (you’ll need to scroll down to this)

3. Enter a Filename and click on Save.

4. Choose Current Slide Only or Every Slide
_________________________________
Differences in Microsoft Word

The following topics are things that work a little differently in Microsoft Word than in PowerPoint.

Turn off Drawing Canvas

When using the drawing tools in Word, such as the oval tool, a Drawing Canvas automatically appears and makes drawing difficult. Use the following steps to turn Off the drawing canvas:

1. Tools menu, Options
2. Click on the General tab
3. Turn off “Automatically Create Drawing Canvas when inserting AutoShapes”.

4. Click on OK
Make Picture Floating
In Word, Clip Art and pictures you insert are not floating, which means you cannot automatically move them anywhere on the page. Use the following steps to make a picture floating:

1. Click on the picture to select it. The Picture toolbar should be displayed. If not, right-click on the picture and choose Show Picture Toolbar.

2. Click on the Text Wrap tool [image: image26.png]


 and choose Tight
Make WordArt Floating

In Word, WordArt objects you insert are not floating, which means you cannot automatically move them anywhere on the page. Use the following steps to make a WordArt floating:

1. Click on the WordArt to select it. The WordArt toolbar should be displayed. If not, right-click on the picture and choose Show WordArt Toolbar.

2. Click on the Text Wrap tool [image: image27.png]


 and choose Tight
Select Objects Tool [image: image28.png]



The Select Objects tool on the Drawing toolbar allows you to select objects you have drawn, even if they are behind text.

Text Boxes – Setting Text Wrap

In Word, text does not automatically wrap around text boxes. Use the following steps to set text wrap on a text box.

1. Double-click on the border of the text box

2. Click on the Layout tab and choose Tight
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